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1	 Welcome to MASSIVE!
Thank you for choosing MASSIVE!

1.1	 What is MASSIVE?

MASSIVE is a flexible polyphonic synthesizer using dynamic wavetable oscillators, two multi-
mode filters with variable routing and a host of modulation sources including step sequencers 
and easy to use curve editors 

MASSIVE combines a unique synthesis engine with unparalleled ease of use. This synthesizer 
is your solution for punchy bass lines and cutting leads, while at the same time it is also 
capable of beautifully atmospheric pads and funky rhythmic grooves. No matter if you just 
want to produce fresh music by using the roundabout 600 production-ready KORE SOUNDS® 
that come with MASSIVE or if you are an experienced sound designer eager to dive into the 
depth of sound synthesis—MASSIVE just delivers.

1.2	 The MASSIVE Documentation

1.2.1	 Special Notes in this Getting Started Guide
This manual uses special notes to provide additional tips and to warn you of things that can go 
wrong. The icons included in the marginal notes show the nature of the provided information:

Whenever this exclamation mark icon appears, you should read the corresponding paragraph 
carefully and follow the instructions and hints given there (if applicable).

SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen
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This light bulb icon indicates that a paragraph contains useful extra information. This informa-
tion may often help you to solve a task more efficiently, but does not necessarily apply to the 
setup or operating system you are using. However, it should be worth reading for most users.

1.2.2	 Other Documentation
What you are holding in your hands right now is the Getting Started Manual that will give 
you a quick overview of MASSIVE’s main features and functions. For more in-depth informa-
tion on all topics not covered here, please refer to the MASSIVE Reference Manual that is 
available as a PDF file in the subfolder “Documentation” of MASSIVE’S installation folder. 
Alternatively, you can download the Reference Manual from the Update Manager on the Native 
Instruments Website:

native-instruments.com

1.3	 System Requirements

For current information about system requirements and compatibility with current and legacy 
operating systems, please see our website at:

native-instruments.com

http://www.native-instruments.com
http://www.native-instruments.com
http://www.native-instruments.com
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2	 Setup
This chapter leads you through the necessary steps for setting up your MASSIVE installation. 
The first part deals with the stand-alone version of MASSIVE. The second section provides 
an overview of the available MASSIVE plug-ins.

2.1	 Setting up MASSIVE in Stand-alone mode

MASSIVE can run as a stand-alone software with its own interface to your sound- and MIDI-
hardware. Use this mode if you only want to play MASSIVE via a MIDI keyboard attached to 
your computer or if you want MASSIVE to receive MIDI data from a piece of software that 
cannot host any of the available MASSIVE plug-ins.

!
If you start MASSIVE for the first time after installation, please make sure that the data-
base building process has finished before you close the software/plug-in again. See the 

next section for more.

2.1.1	 Initial Database Build
The KORE SOUNDS® in MASSIVE are organized in a convenient database making sound 
retrieval and management a snap. For further information about working with the sound da-
tabase please read chapter 4.1 “Finding and Loading Sounds”.

The first time you start MASSIVE (stand-alone or one of the plug-ins) you get a message that 
MASSIVE’s KORE SOUND database has to be created.

The Mac OS X version of MASSIVE complaining about the missing database.
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Depending on the performance level of your computer hardware this can take a few minutes. 
MASSIVE indicates that it is working on the database with a small rotating ring symbol directly 
left of the NI Logo in the Navigation Bar of the interface.

The small rotating ring on the Navigation Bar indicates database processing.

Please make sure that this procedure has come to an end before you close the application or 
plug-in. When the database creation has been finished, the ring stops to rotate. If you close 
it before it has finished MASSIVE has to start all over again the next time you start it.

2.1.2	 Audio and MIDI Settings
Before you start your work with MASSIVE it is a good idea to configure its audio settings to 
fit your needs. This only applies to the stand-alone version of MASSIVE as with the MASSIVE 
plug-ins all things audio and MIDI are handled by the host software.

The Audio Hardware
1.	 Do the following to set up your audio hardware in MASSIVE:

2.	 Choose the entry Audio and MIDI Settings… from the File menu

	

	 The Audio Tab of the Audio and MIDI Settings showing a RIG KONTROL 3 as the active audio hardware 		
	 (Windows version shown).
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3.	 From the Driver menu of the Audio Tab, select ASIO on Windows for best results (On a 
Mac this will be set to CoreAudio, your only choice in Mac OS X.).

4.	 Use the Device menu to select the desired audio interface.

5.	 We recommend setting the sample rate to 44100 and setting the output latency to about 
10 ms. Depending on your hardware this may be done via the Latency Slider on the bot-
tom of the Audio Tab or via the Button ASIO Config that opens the control panel of your 
audio interface.

These are recommended settings that should work well on most computer systems; for infor-
mation on what these settings mean, please refer to chapter 2.2 “About Latencies”.

The MIDI Hardware
For using MASSIVE with a MIDI keyboard you have to choose the right MIDI interface so that 
the MIDI data reaches MASSIVE.

To do this: 

1.	 Open the Audio and MIDI Settings from the File Menu.

2.	 Switch to the MIDI Tab

	

	 The MIDI Tab of the Audio and MIDI Settings showing an active RIG KONTROL 3 MIDI interface 		
	 (Windows version shown).



MASSIVE – 11

3.	 On the MIDI Tab, check that the MIDI interface or device you are using is turned on. If you 
see your interface listed but it is off, click on the “off” label to turn it on.

4.	 Now you should be able to play MASSIVE via your MIDI keyboard.

If you don’t have a MIDI controller available, you can still play MIDI notes by using the com-
puter’s keyboard. We have assigned the four rows of alphanumeric keys in a similar pattern 
to that of a piano keyboard. For example, the bottom row of keys on your computer keyboard 
(from Z on the left to / on the right) is assigned to the white keys of the piano keyboard, with 
the Z key being assigned to C. The row of keys above that (from S to ;) covers the correspond-
ing black keys, with S assigned to C#. The two rows of keys above are assigned in a similar 
pattern, but one octave higher.

2.2	 About Latencies

The data produced by audio software like MASSIVE has to be handed over to the driver of 
the currently used audio hardware which in turn passes it to the digital to analog converters 
that produce an analog signal to be heard via your speakers. This procedure takes time. The 
resulting delay is called latency.

The high performance level of current computer hardware combined with advances in driver 
technologies has reduced the required time to a few milliseconds. Still, there is a trade-off to 
be made, as an extremely low latency taxes the computer resources more than a lax setting 
with a longer delay between sound production in the software and sound reproduction via 
the speakers.

The nature of the driver used is also an important factor in this game.

Use low-latency drivers
Whenever possible you should use low-latency drivers while working with MASSIVE. MASSIVE 
works with two types of low-latency drivers:

•• ASIO drivers

•• Core Audio (only on computer running Mac OS X)

These two technologies ensure an efficient data transfer between Software and audio hardware 
and should provide a latency that is bearable for live play, if not unnoticeable.
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2.3	 MASSIVE as a Plug-in

MASSIVE does not only come as a stand-alone application but also in a variety of plug-in 
formats for use in hosts like Native Instruments KORE, Steinberg Cubase/Nuendo, Ableton 
Live, MOTU Digital Performer, Apple Logic or Digidesign Pro Tools.

The synthesis functionality of the MASSIVE plug-ins is identical to the stand-alone version. 
However, the plug-ins lack the options for settings up audio and MIDI hardware as this is 
handled by the host the plug-in is working in.

Plug-in Formats and Hosts
Depending on the operating system running on your computer you have the choice between 
the following plug-in formats:

•• VSTi (Mac OS X and Windows)

•• Audio Unit (Mac OS X only)

•• RTAS (Mac OS X and Windows for the use in Digidesign Pro Tools)

Please refer to the documentation of your host software for details about the required plug-in 
format and how to open and use the MASSIVE plug-in.
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3	 MASSIVE Overview
This chapter provides a brief overview of MASSIVE’S user Interface.

This document is about setting you up for your first steps in MASSIVE so we will not be able 
to dive into all the functionality offered by this synthesizer. Please read the main manual for 
an in-depth discussion of all features to be found in MASSIVE.

3.1	 Some Interface conventions

One of the assets of MASSIVE is its user interface. Its clear structure and innovative modula-
tion controls lead to an elegant workflow.

Sliders, knobs and number boxes
Faders, knobs and number boxes are used to control most of MASSIVE’s major functions. In 
general these work the same way as the controls you may be used to in other audio software: 
simply click with the mouse and drag up and down (while holding down the mouse button) 
to alter the value.

These commands and control options are available throughout MASSIVE:

•• Hold the keyboard’s shift key while changing the value with the left mouse button to make 
finer adjustments to a control.

•• You can also use the mouse wheel to change the value of a control; if you hold down the 
shift key while using the mouse wheel, the value will change in coarser steps.

•• Double-click with the left mouse button to reset the value to its default.
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3.2	 The Navigation Bar

The Navigation Bar is always visible and provides information about the currently uses KORE 
SOUND, the number of voices used and the CPU load. Here you also find some menus to 
save sounds and manipulate MASSIVE’s Options and the View Buttons (see below).

The Views
You get around on MASSIVE’s user interface by using the View Buttons.

Use the View Buttons to switch around the interface.

As you can see, the parts of the user interface are:

•• Synth View: Here you find the sound design interface with all parameters of the synthe-
sis engine.

•• Attibutes View: This is the interface for tagging your sound creations with a comprehen-
sive set of Attributes for subsequent retrieval via the Browser.

•• Browser View: Your one-stop solution for organizing, finding and loading KORE SOUNDs 
in MASSIVE.

•• We will start our quick tour around the interface with the Browser, as it is needed to ac-
cess the factory content.
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3.3	 The Browser View

MASSIVE offers a large sound library of KORE SOUNDS so that you can start to make music 
immediately. The sounds are organized in a powerful database and tagged with a number of 
categorized Attributes that facilitate the search and retrieval of sounds to a new degree. 

As the name implies, the KORE SOUNDS integrate seamlessly into Native Instrument KORE 
as well as being the native sound format for MASSIVE.

Click on the Browser Button and you see the Browser filling up the lower part of the interface:

MASSIVE’s Browser ready for sound retrieval.

On the upper left edge you see the Search Field of the Browser. Below it you find the Attributes 
divided into five categories and to the right you have the Search Results List presenting the 
contents of MASSIVE’s KORE SOUND database.
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3.4	 The Attributes View

After creating your own KORE SOUNDS with MASSIVE you will want to save your work. This 
is the moment to take a few seconds of time and tag it with a few Attributes.

This is done on the Attributes View.

This will make the future retrieval of the Sound a lot easier as the sound will integrate well 
with the search workflow described in section 4.1 “Finding and Loading Sounds”.
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3.5	 The Synth View

All sound design work in MASSIVE takes place on the Synth View. Switch it on by clicking 
on the Synth Button in the Navigation Bar.

Now you see MASSIVE’s sound design environment in its full glory:

MASSIVE’s user interface in Synth View.
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3.5.1	 Oscillator Section
On the left you see the Oscillator Section. It includes three Wavetable Oscillators, a Modulation 
Oscillator that can be used to modulate any or all of these wavetable oscillators, a Noise 
Generator, and a Feedback Section.

The Oscillator section is MASSIVE’s sound source.
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3.5.2	 Filter Section
To the right of the first two oscillators we have the two multimode Filters with their Routing 
Faders and the Mix Control:

MASSIVE’s filter section.

3.5.3	 Insert Effects
The Insert Effects sit on the lower part of MASSIVE’s user interface:

The Insert Effects on the lower part of the interface.

These can be moved around in the signal flow (see main manual for more on this). Please 
have a look at the reference manual for a detailed description of all available Insert Effects 
algorithms. 
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3.5.4	 Output Sections
The Output Sections on the top right part of the interface has a few sub-sections: two Master 
Effects, an Equalizer, Amplifier Section, Bypass Section and the Master Volume. 

Please have a look at the reference manual for a detailed description of all available Master 
Effects algorithms.
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3.5.5	 The Center Window

The Center Window serves as a display for editing a variety of other parameters that do not 
need to be accessed so frequently, as well as in-depth editing of your modulation sources.

The Center Window display can be switched between eight Modulation Sources and six pages 
of General Settings. You can choose which page of controls to access by clicking one of the 
two rows of labeled tabs across the top of the Center Window. Please read chapter 4.8.1 
“General Pages” in the reference manual for details.

The eight Modulation Sources are grouped into envelopes (slots 1-4) and assignable pages 
(slots 5-8) that allow you to choose between the LFO, Performer, and Stepper modulation 
sources. If you have chosen one of these assignable slots, you can choose one of these types 
by using the popup menu in the upper-right corner of the modulation source page. For an in-
depth discussion of the Modulation Sources please have a look at chapter 4.8.2 “Modulation 
Pages” in the reference manual.
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3.5.6	 Macro Controls
The Macro Controls are found in the lower right corner of MASSIVE’s panel when you are in 
the Synth View. They help unify your interaction with all of the other controls in MASSIVE, 
particularly when you are trying to make music instead of just creating and programming new 
sounds. Like the modulation sources of the Center Window (the envelopes, LFOs, Stepper 
and Performer),

each Macro Control knob provides a Modulation Handle. With this handle the Macro Controls 
can be assigned to any parameter of MASSIVE as a modulation source, i.e. any changes to 
the value of the Macro Control are then mapped onto the modulated parameter. You can uti-
lize their MIDI Learn functionality to assign them to a knob or fader of your MIDI controller 
(right-click on a Macro Knob to get a menu).

At the left, there are four small yellow controllers available which can be assigned to modula-
tion destinations in MASSIVE. Each of these routes modulation data triggered by an external 
MIDI keyboard or MIDI sequence to the modulation target.

•• KTr (Keytracking): Generates a modulation signal depending on the pitch of the played 
MIDI note.

•• TrR (Trigger Random): Each played MIDI note trigger generates a new random value at 
the output of the TrR modulation source.

•• AT (Aftertouch): The modulation source provides the aftertouch value of your MIDI mes-
sages. Note that few MIDI keyboards send aftertouch information.

•• Vel (Velocity): This modulation source relays velocity data from your MIDI keyboard or 
other MIDI controller.
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4	 Basic Operation
With setup and interface basics covered, let’s dive into the fun part: Using MASSIVE to make 
some noise!

This chapter is divided into two main sections. The first one deals about the basics of finding, 
loading and playing KORE SOUNDS from the MASSIVE sound library. You will get acquainted 
with the powerful Browser View and learn about using Attributes to find the desired sounds.

The second part circles around your first endeavors into the realm of MASSIVE sound design 
and you will learn the basics about MASSIVE’s amazing sound sculpting features.

4.1	 Finding and Loading Sounds

Here you will get a kick-start into quickly finding and loading KORE SOUNDS via MASSIVE’s 
browser.

4.1.1	 Using the Browser
MASSIVE offers a large sound library of KORE SOUNDS so that you can start to make music 
immediately. The sounds are organized in a powerful database and tagged with a number 
of categorized Attributes that facilitates the search and retrieval of sounds to a new degree. 

As the name implies, the KORE SOUNDS integrate seamlessly into Native Instrument KORE 
as well as being the native sound format for MASSIVE.

In MASSIVE you use the Browser View to load sounds. The View is switched on via the Browser 
Button on the right part of the Navigation Bar.

The Navigation Bar of MASSIVE’s interface with the Browser Button on the right.
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Click on the Browser Button and you see the Browser filling up the lower part of the interface:

MASSIVE’s Browser ready for sound retrieval.

On the upper left edge you see the Search Field of the Browser. Below it you find the Attributes 
divided into five categories and to the right you have the Search Results List presenting the 
contents of MASSIVE’s KORE SOUND database.

If you just want to scan through the complete contents of the database, use the scroll bar of 
the Search Results List to browse the KORE SOUNDS. Load a sound with a double-click on 
its name.
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4.1.2	 Combining Attributes
But there is a more elegant way of getting the sounds you want: the Attributes.

Let us say you are looking for a mean, digital bass for a track you are working on:

1.	 In the Instruments category, click on Bass.

2.	 In the Source Category, Digital seems appropriate, so select this.

3.	 Under Timbre, choose Hard.

4.	 As you want the sound to bite you choose Percussive under Articulation. The Genre 
column can be left untouched in our example. Now you see the following picture: 

	

	 Your Search Results in the Browser.

	 With each selected Attribute the list of KORE SOUNDS displayed in the Search Results 
List gets smaller, as fewer sounds match the combination of selected Attributes.

5.	 Now double-click one of the entries on the Search Results List, and the corresponding 
KORE SOUND is ready to be played.

6.	 The loaded KORE SOUND appears in the Preset Selector of the Navigation Bar.

	
	 The KORE SOUND Rudebox has been loaded.

7.	 The Search Results List is always mirrored in the Preset Selector menu. Click on it and 
you get a drop-down list.
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	 The Search Results appear in the Preset Selector menu. 

	 The two small up and down arrows at the menu’s right allow you to step through the list 
without opening the popup menu.

Now you know how to find and load KORE SOUNDS in MASSIVE. Have fun with the great 
selection of sounds that comes with MASSIVE.

For a more in-depth discussion of the Browser’s functionality, please read the reference manual 
that came with your installation of MASSIVE.

4.1.3	 Searching Sounds
Sometimes you want to quickly find a KORE SOUND you have used before. You only know a 
part of its name and do not want to go through the Attributes to find it. This is easily done 
via the Search functionality of the Browser.

Just type a part of its name into the Search Field and you get a list of KORE SOUNDS match-
ing your search. As an example we will search for a KORE SOUND that has the term “Dub” 
in its name or Meta information (see chapter 4.4.1 for more on Meta Information):

 

 
Searching for Dub.

Browse the Search Results List and you will quickly find the sound you were looking for.
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4.2	 Tweak the Sound

MASSIVE’s KORE SOUNDS are no static presets. Many of them are very malleable without 
having to touch the actual synthesis parameters. This easy control often rivals the possibilities 
of other synthesizers. This functionality is implemented via the Macro Controls. 

You find the Macro Controls on top of the Browser and Attribute Views and in the lower right 
corner of the Synth View.

The Macro Controls of the KORE SOUND “Cosy Cose” in the Attribute/Browser View.

The functions presented on the eight knobs of the Macro Controls vary from sound to sound, 
as they are programmed by the sound designer. So just take your time, experiment a bit and 
you will be rewarded with a wide palette of sound variations.

If you are using MASSIVE as a plug-in Native Instruments KORE with its KORE-Controller, the 
Macro Controls are automatically mapped to the knobs of the Controller and you can tweak 
away while you play.

If you have a generic MIDI controller connected to your computer, you can easily map the 
controllers of your hardware to the knobs of the software. Please have a look at the reference 
manual for MASSIVE for more details on this.
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4.3	 Create Your Own Sound

MASSIVE is a sound designer’s dream come true. Powerful synthesis features are combined 
with a very accessible and quick user interface making the creation of new sounds a breeze. 
It doesn’t matter if you are a novice or a seasoned sound wizard – MASSIVE just delivers.

This section contains a brief overview of MASSIVE’s synthesis engine by introducing the vari-
ous elements along the signal flow while developing a simple synth-bass sound from scratch. 
The sound will be of the aggressive type with lots of low end and a snappy attack.

The first step in creating your sound is to open a new default KORE SOUND from MASSIVE’S 
File menu in the Navigation Bar (NOT from the File menu of the standalone software).

1.	 Switch into Synth View with a click on the Synth Button.

2.	 Click on the File menu and choose New Sound. You see the following picture:  

	 This is the default init-sound of MASSIVE.

Now you have a generic sawtooth waveform as a blank slate to start with the bass sound.
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4.3.1	 The Oscillators
The basis of any synthesizer sound is the oscillator, so that is exactly where we start our 
journey. Direct your focus to Oscillator 1 and read on.

1.	 The core of our bass sound is a wavetable called Roughmath III. It has a rough and grai-
ny sound that should be perfect for our bass sound. Choose it from the second column 
(Basic) of the Wavetable menu of Oscillator 1. Note that RoughMath III gets abbreviated 
to Math III when you close the menu.

	

2.	 As basses play low, set the Pitch to -12 semitones by clicking the number box and drag-
ging the mouse downwards. Your Oscillator should look like this:

	

3.	 Note that the Routing Fader to the right is set in the middle between Filter 1 (F1) and 
Filter 2 (F2), so that the signal of Oscillator 1 is going into both Filters. We want it to be 
filtered by Filter1 and at the same time we want the raw sound to run through Filter 2 
unchanged. More about this later.

4.	 Play some notes and turn the knob WT-position to sweep through the wavetable. Leave 
the knob Wt-position fully turned counterclockwise.

5.	 Switch on Oscillator 2 by clicking on its Mute Switch (the small circle left of its name). 
Oscillator 2 will act as a sub-oscillator adding more low-end to the sound.
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6.	 Choose the wavetable Sin-Square in the column Basic of the Wavetable Menu of Oscillator 2.

	

7.	 This wavtable interpolates between a sine wave and a square wave. Pull the knob Wt-
position completely counterclockwise to get a sine wave and dial in a Pitch value of -24 
semitones. This is an octave below the frequency of Oscillator 1.

	

8.	 Drag the Routing Fader of Oscillator 2 completely down to route its signal into Filter 2, 
only (see picture above).

Now you have laid out the basis for our bass sound. Two oscillators with the first one provid-
ing lots of harmonics to filter and make the sound interesting and the second one adding low 
frequencies.

Note that the signal of Oscillator 1 is routed into both filters with equal volume. Later on we 
will use the second filter as a bypass stage so the raw sound of Oscillator 1 can still be heard.
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4.3.2	 The Filters
Filters are at the heart of subtractive synthesis. They attenuate the frequencies below or above 
a cutoff frequency which can be controlled and modulated. There are other filter types that 
work differently, but for our tutorial we will only use a straightforward low pass filter. Have a 
look at the reference manual for details about the available filter types.

1.	 We will use a fast resonant low pass filter-sweep to add to the punch of the sound. Also, 
the sine wave from Oscillator 2 has to pass unfiltered, so we will split the signal path for 
the oscillators. Drag the Input Fader (labeled F2) of the Filters completely down to get 
two parallel filters.

	

2.	 Now choose the filter-type Lowpass 4 from the Type menu of Filter 1.
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3.	 Set the Resonance of Filter 1 to a fairly high value, as shown in the picture below. The 
resonance boosts the volume of the frequencies around the filter cutoff frequency and 
thereby adds character to the sound. Later in this tutorial we will modulate the cutoff 
with an envelope generator. 

	

We are going to use Filter 2 as a bypass stage for the sine wave (remember, the sig-
nal of Oscillator 2 only goes into Filter 2), so turn its Output Fader all the way 
up. The Filter Type should stay None which equals a bypassed filter. The sine 
wave of Oscillator one is only to add low frequencies so there is no use in filtering it. 
Your filters should look like in the following picture:

	

4.	 The sound is going to be a mixture of the two filter outputs with Filter 1 modulated by 
an envelope for the Attack (in combination with the wavetable sweep, see below) and the 
clean sound of both oscillators going through filter 2 unaltered for the sustain phase of 
the sound.
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	 Set the Mix Fader of the Filters to a high value as shown below. This fader controls the 
balance between the two output signals of the filters.

	

With the filter settings you have set the basis for an additional attack transient while the raw 
sound of the oscillators still being heard through the bypassed second filter. Especially the 
unaltered sound of Oscillator 1 is important for the character of our synth-bass.

4.3.3	 The Modulation Sources
To shape the attack phase of our bass sound we are going to put envelopes with a fast decay 
time on the wavetable position and the filter cutoff. This leads to a transient attack phase 
which provides punch to the sound.

1.	 Switch the Center Window to display Envelope 1 by clicking on 1 Env. The envelopes are 
tools to modulate the parameters of MASSIVE over time. 

2.	 Set the Attack knob to zero and the Decay knob to a short value and the Decay Level to 
zero, as displayed below.
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	 This envelope shape leads to a very quick run-up of the value to the maximum. After the 
peak is reached it runs down to zero with the time defined by the parameter Decay.

3.	 Now click on the Modulation Handle of Envelope 1 (the little cross at the right of its tab 
header), keep the mouse button down and drag it onto the Modulation Slot of the Wt-
Position knob of Oscillator 1. Let go of the Mouse button. You see a blue 1 sitting in the 
slot that means Envelope 1 is the modulation source for the wavetable position:

	

4.	 Click on the blue 1 and drag the mouse upwards. A ring runs around the knob to depict 
the positive modulation amount. We want it to sweep the full range of the wavetable.

	

	 Now the wavetable follows Envelope 1. 

5.	 To add a juicy click to the attack transient of our sound we want the first filter to be mo-
dulated by Envelope 2. Switch the Center window to Envelope 2 (by clicking on the tab 
2 Env) and set the Attack time to zero, the Decay time to a small value and the Decay 
Level to zero. The decay should be faster than with the wavetable modulation described 
above. It should look like this:

	



MASSIVE – 35

6.	 Now drag the Modulation Handle of Envelope 2 into the Modulation Slot of Filter 1 and 
drag the mouse up to the maximum modulation amount.

	

You just connected the outputs of two envelopes to control the Wt-position of Oscillator 1 
and the Cutoff of Filter 1, respectively. This will give our bass sound a nice, snappy attack. 
Play around with the Decay times a bit to get a feel for them.

4.3.4	 The Effects
The bass sound is not as nasty yet, as it could be. We are going to spice it up with some tube 
distortion and add a little low end with the EQ.

1.	 Choose the effect Classic Tube from the menu of the Master Effect FX 1.

	

2.	 Dial down the Drive value a little bit, as shown in the following picture:
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3.	 Switch over to the Master EQ and give the lower frequencies a little boost by turning the 
Low Shelf knob clockwise.

	

Now our bass is getting up to speed. The Tube effect adds some grit and we boosted the low 
frequency a bit for more oomph. 

4.3.5	 Feedback
To get an even better low-end frequency response, we are going to add some feedback to the 
signal path. To do this:

! 
Be careful with the Feedback Knob. If you are playing on high volumes feedback can lead 
to extreme loudness damaging your ears or speakers!

1.	 Activate the Feedback via its Mute switch. The small circle should light up blue.

2.	 Dial in the Amp knob to a setting around 12 o’clock. Use your ears while playing to find 
the sweet spot. Be careful! Feedback can lead to very loud and distorted sounds.

	

3.	 Now the signal path is tapped before the Master Effects and the sound is fed back into 
the two filters (have a look at the Routing tab of the Center window to understand the 
signal flow).

4.	 Adjust the Master Volume so that it doesn’t hit the red overload display.

Congratulations! You just programmed a nice bass sound.

Go ahead and read the next sections for information about tagging and saving your new KORE 
SOUND for future use.
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4.4	 Tagging and Saving Sounds

Once you have created your first MASSIVE KORE SOUND, it is of course important to save 
it so that you can use it again at a later time.

4.4.1	 Assigning Attributes
If you are content with your sound design work and are ready to save your new creation just 
take a few seconds of time to tag it with some Attributes. This will make the future retrieval 
of the Sound a lot easier as the sound will integrate well with the search workflow described 
in section 4.1 “Finding and Loading Sounds”.

The Assignment of Attributes has its own View in MASSIVE. Tagging your sound involves the 
following steps:

1.	 Click on the Attributes button to switch it on. You see the following interface in the lower 
part of MASSIVE’s window, representing an empty palette of Attributes:

	

2.	 Now choose some Attributes that fit your new KORE SOUND by clicking 
them. They will change their color to yellow, as shown in the following picture: 
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3.	 Type in your Name into the Author field of the Meta Information. You can also add a 
comment. The Comment field will be evaluated when you search for a KORE SOUND.

Now your KORE SOUND has all the necessary information to be saved into MASSIVE’s sound 
database. Read the next section and you will learn how to do that.

Please refer to chapter 4.10 “The Browser and Attribute Views” in the MASSIVE reference 
manual for an in-depth discussion of Categories; Attributes and meta information.
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4.4.2	 Saving the Sound
Saving sounds in MASSIVE is straightforward:

1.	 Click on the Save button in the Navigation Bar.

	

	 The Save button in the Navigation Bar of MASSIVE.

2.	 A file dialog pops up.

3.	 Type in the desired name for your new KORE SOUND.

	

	 The Save File dialog (Windows XP version shown).

4.	 Click on [Save] and you are done.

Now your new KORE SOUND is integrated into MASSIVE’s database of sounds. You can re-
trieve it by searching for its name in the Browser.

%
If a user KORE SOUND was already saved into the database before and you click the Save 
button in the Navigation Bar, the KORE SOUND will be overwritten with the changes made 

to it since it was opened. You can use Save As to avoid this.

For more information about KORE SOUNDs including the location of the underlying files on 
your file system, please refer to the main manual of MASSIVE. It has been installed as a PDF 
file on your computer.
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5	 What’s next?
With all the basics of MASSIVE now covered you should go on and further explore. If you 
just want to use MASSIVE’s collection of factory KORE SOUNDs have a look at the website 
of Native Instruments for additional content.

For creating you own sounds you will certainly refer to the reference manual that came as a 
PDF document with your MASSIVE installation. There you will find everything you need to 
know to develop fresh sound creations.

Have fun and make lots of music!
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